Chapter 6. Entering and Managing Data in HAZUS

HAZUS contains a variety of default parameters and databases. You can run a loss
estimation analysis using only default data (Chapter 3), but your results will be subject to
a great deal of uncertainty. If you wish to reduce the uncertainty associated with your
results, you can augment or replace the default information with improved data collected
for your region of study. You will find that HAZUS contains spreadsheets for entering
data and several additional utilities that were developed to assist in organizing your
inventory data. The following sections provide information on importing data, entering
data through HAZUS windows, and managing the data.

As has been discussed in earlier sections, it is very likely that data obtained from different
sources will not be in the same format. Furthermore, the data may contain a different
number of fields than the databases defined in HAZUS. This will require putting the data
in the correct format to ensure compatibility with HAZUS databases. An import
database utility has been developed to help you convert databases to the HAZUS format
(Section 6.2.1).

6.1 Importing GIS and Graphic Files

Many municipalities and lifeline operators are currently using a GIS to maintain
databases of their facilities. There are a number of formats that HAZUS can accept for
graphic or geographic data. Some can be opened without converting to another format,
while others will require conversion.

6.1.1 Opening ArclInfo Files in ArcView

ArcInfo coverage files (*.e00) can be opened directly in ArcView. To open an ArcInfo
file in ArcView, you start by making the View window active. Choose the Add Theme
option from the View menu. Make sure that the Data Source Types: is pointed to
Feature Data Source. Select the desired coverage file and click the OK button (Figure
6.1).
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Figure 6.1 Opening ArcInfo files in ArcView.
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6.1.2 Importing Maplnfo Files in ArcView

Maplnfo files cannot be opened directly in ArcView. A special import utility that
converts MaplInfo (*.mif) files to ArcView(*.shp) files is generally packaged with the
ArcView software and is installed automatically on your system when ArcView is
installed.

6.1.3 Opening Atlas GIS Files in ArcView

Atlas GIS exports ArcInfo (*.e00) files that can be directly opened in ArcView as
described in Section 6.1.1.

6.1.4 Opening AutoCAD (*.dx{f) Files in ArcView

A special ArcView extension can be purchased separately from ESRI that will allow the
conversion of AutoCAD (*.dxf) files to ArcView (*.shp) files.

6.1.5 Digitized Maps

ArcInfo has the ability to read and display a variety of image formats. These formats
include: *.bsq, *.jpg (when the JPEG Image extension that comes with ArcView is
loaded), *.tif, *.gis, and *.bil.

To add an image to a view, click the Add Theme button. In the dialog box that appears
(shown in Figure 6.2), choose Image Data Source from the Data Source Types and
navigate to the directory that contains the image you want to add. Select the image file
and click the OK button. Check the box next to the theme’s name in the table of contents
of the Map View window to be able to see the image. It is important to understand that
scanned images can be displayed in HAZUS but cannot be used for analysis.
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Figure 6.2 Opening an Image file in ArcView.

6.2 Opening Database Files into HAZUS

In some cases, the user can acquire inventory information databases from local agencies
in electronic files. To open such file in HAZUS, they must be in a (*.dbf) format. Other
formats will require to you to use a database manager external to HAZUS for converting
the file to a (*.dbf) format. These types of files are discussed in Sections 6.2.3 through
6.2.6.
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6.2.1 The Import Database Utility

A database import utility has been developed to assist you in converting an electronic
database to the appropriate format for HAZUS. Clicking on the right mouse button
accesses this import utility. The Database Management Tools menu, shown in Figure
6.3, will appear. Select the Import database and the dialog box shown in Figure 6.4 will
appear. Click on the name of the file you want to import and click the OK button.
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Figure 6.3 Accessing the database menu.
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Figure 6.4 Window used to identify the location of a database to be imported.

The mapping window shown in Figure 6.5 is used to map the fields in your database (the
source) to the fields used in the HAZUS database (the target database). The Database
Dictionary in Appendix E contains the names and structures of all of the databases that
are used by HAZUS. From the Database Dictionary you can determine the names of the
target fields. The Database Dictionary, in an abbreviated, form is available interactively
in HAZUS. To access the Dictionary, click on the right mouse button, and using the
menu shown in Figure 6.3, click on Dictionary. An example of the Database Dictionary
is shown in Figure 6.6.
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Figure 6.5 Mapping the fields of your data file to the HAZUS data structure,
when importing a site-specific database.
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Figure 6.6 Interactive database dictionary.

The fields from the Source menu do not have to be in the same order nor do they have to
have the same names as the fields in the Target menu. For example, in Figure 6.5, the
year the school was built is in a field called “YEAR BUILT” in the Source file, whereas
the field that contains this information is in the “YEAR B” field in the Target file. To
define the desired mapping, simply click on a field name from the Source menu (e.g.
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LON) and the corresponding field name from the Target menu (e.g. LONG) and then
click on the Add button. After performing these steps, the mapping you have defined
will disappear from the Source and Target menus and will appear in the Mapping
Results box at the bottom of the window. If you make a mistake, click the Delete button,
and the last mapping pair you have defined will be undone. In this example, the user has
already defined six relationships and is in the process of defining a seventh. When you
have completed defining all of the information, click on the OK button, wait a few
seconds, and your imported database will be displayed in HAZUS. NOTE: You do not
have to map all of the fields from the Source menu. However, any fields you do not map
will not be imported into the Target database.

It is possible to have several databases with the same format. To save the mapping that
you have defined so that it can be reapplied to other files, click the Save button in Figure
6.5 and the dialog box shown in Figure 6.7 will appear. Enter a name for the mapping
scheme and click the OK button. To retrieve the saved mapping, click on the Load
button in Figure 6.5.

Save As HE

Sawve in: Ia Priind j gl I_é_

File name: Ischuul.sav{ Sawve |
Save as type: ISaved mapping *.sav) LI Crarizel |

Figure 6.7 Saving a database mapping scheme.

6.2.2 Instructions for Opening dBASE (*.dbf) Files in ArcView

Files in a (*.dbf) format can be directly opened into ArcView. To open a (*.dbf) file in
ArcView, select Add Table from the Project menu, shown in Figure 6.8, and an Add
Table dialog box will appear as shown in Figure 6.9.
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Figure 6.8 Project menu in ArcView.
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Figure 6.9 Opening a table in ArcView.

Choose dBASE (*.dbf) from the List Files of Type: box in the lower left corner of the
Add Table dialog box. Select the drive and directory that contains your file the select
the file to be opened. Click the OK button.
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6.2.3 Opening Excel (*.xls) Files in ArcView

ArcView can read dBASE, INFO (INFO is the database built into ArcInfo software), and
tab- or comma-delimited text files. If you have inventory information saved in an Excel
spreadsheet (*.xls), you will need to convert it to a (*.dbf) format. To convert the file,
use the following steps:

1) Open the file in Excel. Be sure that all of the columns in the spreadsheet are wide
enough so that all of the data in each column is showing. Anything that is hidden
behind another column will be truncated when you save the file in a (*.dbf) format.

2) Highlight all the columns and rows that you would like to include in the (*.dbf)
format file.

3) From the File menu, select Save As.

4) Select the drive and directory that the file should be saved to. From the Save as type:
menu, select the file type. As illustrated in Figure 6.9, you should select dBASE
DBF.

Save Copy of Table As HE
Save in: Ia Hazus j gl = E
Diata
Diata?
Ini
Lacnty
Priind
System
Template
File name: Isrbndry.tab Sawve I
Sawve as type:  |dBASE DBEF LI Cancel |
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Maplnfo version 2.x Help |
Microsoft Access Database Projection |

Figure 6.10 Saving an Excel file in a dBASE format.
5) Click on the Save button.

6.2.4 Instructions for Importing Paradox (*.db) Files into ArcView

Paradox files (*.db) cannot be opened directly in ArcView. To open a (*.db) file, you
must open the file in Paradox and convert it from (*.db) to (*.dbf) file type. Now you
can open the (*.dbf) file directly in ArcView as explained in Section 6.2.2.

6.2.5 Instructions for Opening ASCII Delimited Files in ArcView

Files in an ASCII Tab or Comma Delimited format can be opened directly in ArcView.
To open a Tab- or Comma Delimited file, select Add Table from the Project menu
(Figure 6.8). Choose Delimited Text (*.txt) from the List Files of Type: box in the lower
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left corner of the Add Table dialog box. Select the drive and directory that contains your
files. Select the file to be opened. Click the OK button.

6.2.6 Instructions for Importing ASCII Fixed Length Files into ArcView

ASCII Fixed Length Field Files cannot be directly opened in or imported into ArcView.
An external program should be used to convert such a file into an ASCII Tab or Comma
delimited or dBASE file format. Use the procedures discussed in the previous sections to
open the files.

6.3 Adding Records to Site Specific Databases

When you are collecting information about essential facilities, high potential loss
facilities, lifeline components and facilities storing hazardous materials, you will be
collecting and storing the data on a site-by-site basis. Therefore, your databases will
contain sets of records in which each record refers to a particular site. When you identify
a new site, you will need to add a new record.

When you need to add a record to a database, you go to Inventory|(database
category)Inventory data. Clicking on the right mouse button while the mouse is
positioned in the inventory table accesses the database management tools. This provides
you with several utilities for managing your inventory databases. From this menu you
can add, or delete records. You can also import a database that contains a complete set of
sites of interest to you (Section 6.2.1 To add records, place the cursor on the top of data-
sheet and use the right mouse click to access the Add record option. The pop-up menu
shown in Figure 6.11 will appear. This particular example refers to medical care
facilities, but the same steps would be followed for all of the site-specific databases
mentioned above. The only exception is that you cannot use this procedure to add lifeline
components that are represented as lines instead of points (e.g. highway segments,
railway segments, pipeline segments).
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Figure 6.11 The Add Record option

For this example, assume you wish to add two records, you would need to do (right-
mouse click)|/Add Record twice. Every time you add a record, you will be prompt with a
“Save” window dialogue. The medical care facility database has 27 fields for storing
data; however, only a few of these fields are required for defining a record. The required
fields for each database are specified in Appendix E. It is recommended that you give
each record an ID number, although the database will accept your entries without ID
numbers. ID numbers are used for reporting results. Therefore, if you have a several
records without ID numbers you will not be able to associate results with a particular
facility.

The one essential datum element required to define a facility is its location. The only
way to define a location of a facility in HAZUS is to type the longitude and latitude of
the facility. If you don’t know the longitude and latitude of the facility, you would need
to use a geocoder’ to get the longitude and latitude of the location and then add it to the
database in HAZUS.

Once you have defined a location, click on the Close button and the database will be
saved. Alternatively, you can map the database using the Map button or switch to
another database by clicking on the tabs at the top of the window (for example, click on
Schools). In any of these cases the dialog box shown in Figure 6.13 allow you to confirm
the database changes.

> The geocoding process is performed outside HAZUS. Any commercial geocoder
application can be used.
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Figure 6.12 Modified medical care facilities database after adding two records.

HAZUS x|

Data table changed. Save tofile?

Figure 6.13 Confirmation window when data have been changed.

6.3.1 Errors When Adding Records

HAZUS is very strict about enforcing the rule that all inventory data points must fall
within the study region boundary. If you define facility locations that are outside the
study region, HAZUS deletes them and displays the dialog show in Figure 6.14.

2 record ik table EFEMEHGak autzide the study region
boundarny. They are being removed

i

Figure 6.14 Error message when adding records with sites located
outside the study region.
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6.4 Deleting Records from Site Specific Databases

Select the record to be deleted from a database by clicking on the record number on the
left side of the record. To highlight the records shown in Figure 6.15, click on the number
5 and 6. When the records have been selected, use the right mouse button to display the
database management options and select Delete selected record(s).... The dialog box
shown in Figure 6.16 will appear. When you click Yes, the records are deleted.
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Figure 6.15 Selecting a record to delete from a database.

HAZUS [ ]

Areyou sure you want to delete the 1 selected record(s) ?
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Figure 6.16 Confirmation window for deleting a record.

6.5 Editing Records

Data within a record can be edited by double clicking on the spreadsheet cell containing
the data and then highlighting the text to be modified. To highlight the text, hold the left
button of the mouse down while dragging it over the text. Release the mouse and start
typing. The new typing entry will replace the highlighted text.

Alternatively, a facility can be moved by selecting Edit|Start Editing from the map
window (i.e. the window that appears after you map a database). Once you are in an edit
mode, double click on the location to be moved and a box will appear around the symbol
as shown in Figure 6.17. With your mouse button held down, drag and drop the facility
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symbol from its old location to the desired new location. To delete a location, click on
Edit|Start Editing, double click on the location to be deleted and click on Edit|Delete
Features (as shown in Figure 6.17).

Return
@ Start Editing

& Map View _ 8l

H|
¥1 Srbndry shp
]

Figure 6.17 Editing Window

You also have the option of moving or deleting more than one record at a time. To do so,
click on each location, one at a time, while holding the shift key down. Once all the
locations have been selected, release the shift key and follow the above steps for deleting
or moving a record. It is also possible to access the Start Editing and Delete Features
menus by positioning your cursor over the map and clicking the right mouse button.
When you have finished, click on the Return|Return to Table menu. You will be asked
to confirm your changes as shown in Figure 6.18.
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Figure 6.18 Confirmation window for modifying a site-specific database in the
map window.

6.5.1 Synchronizing Databases with Mapping Coordinates

There are two databases that contain your data: a (*.dbf) file and a (*.shp) file. The
(*.dbf) file contains the database as you see it in the spreadsheet. The (*.shp) file
contains the coordinates of the points used to display the points on a map. If you modify
data in the latitude and longitude cells of a record in the spreadsheet, you need to
“Synchronize” the databases so that the spreadsheet and mapped database are displaying
the same information. Synchronizing, which is done with the Synchronize to .MAP
option as shown in Figure 6.3, will update the (*.shp) file so that the mapping coordinates
agree with the spreadsheet.

When data is modified using the map window (Section 6.4), it is automatically
synchronized.

6.6 Lifelines

6.6.1 Adding Lifeline Segments

Lifeline segments must be created using ArcView tools. To add lifeline segments you
must be familiar with the basic functions of ArcView.

6.6.2 Adding Highway Bridges

Adding highway bridges is done using the procedure discussed in Section 6.2. To access
the database, use the Inventory|Iransportation Systems|Inventory Data menu.
HAZUS assumes a default bridge class of HBWS5 (Concrete Construction, Simply
Supported, Multiple Column Bent, Built before 1990 and Constructed outside of
California - see Table A.6 in Appendix A) if no bridge class is supplied.

6.7 Specifying Hazard Maps

Simplified hazard maps are generated during the creation of the study region. These files
are named SOILDEF, LQFDEF, and LNDDEF and are located in the study region
directory. These crude hazard maps are based on default soil maps and the census tract
boundaries and can be modified by a user that has a general understanding of spatial
distribution of the hazards. If digital information is available from experts or other state
agencies, the expert-generated maps should replace the simplified maps.
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Hazard Data Maps |
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1] 4 Cancel

Figure 6.28 Specifying hazard maps in HAZUS.

Soil, liquefaction susceptibility and landslide susceptibility maps are specified in the
window shown in Figure 6.28. This window is accessed from the Hazard|DataMaps
menu. In this example, the default maps generated by HAZUS during the creation of the
study region are specified. To change the name of a file, either type the path name in the
provided box, or click on the button to the right of the box. This button will access the
standard “Open” window as shown in Figure 6.29. It is now possible to move around the
directories to find the needed file. Note: Map files in ArcView are identified by the .shp
extension.

Open B
Look in: I{:‘E Priind _:J EFJ I_
=] afa.shp #| efcare.shp =] Hpmi.shp = Ltr.shp EIE
#] arw.shp #] efemerg.shp =] Hprpf.shp ] Ltu.shp ] it
=] bfa.shp =] efschoal.shp =] hrd.shp =] Mia.shp =] iy
&) cfa.shp =] Ffa.shp ] htu.shp =] Mpl.shp ) st
#] chrstrst. shp ] fire stat shp & Lir.shp #] pfa.shp 8] 5t
=] o shp =] hazmat. shp =] Lia.shp =] Ppl.shp HE
=] crp.shp =] hbr.shp =] Inddef.shp =] Pwishp =] 5t
&) Eta.shp =] hpdams.shp ) Igfdef.shp ] rhr.shp SEL
<] | i
File name: depthdef.shp Open I
Files of type: IEarthq. Map Files *shp) LI Cancel |

Figure 6.29 File open window listing (*.shp) files.
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6.7.1 Modifying Census Tract Centroid Hazard Values

For the general building stock, HAZUS uses a simplified analysis procedure that
aggregates the data and locates the aggregated data at the centroid of the census tract. In
some cases, the soil or susceptibility class determined for the centroid does not represent
the average value for the census tract. HAZUS was designed with a capability to modify
the values based on your observation and understanding. In the following example, the
census tract centroid soil information for a study region is modified. The liquefaction
and landslide maps can also be changed using the same approach. This procedure can
only be completed after a PESH analysis has been run at least once.

1. Display the soil map using Map|Earthquake|Soil Type and the window shown in
Figure 6.30 will appear. Select the “Show hazard values...”. Click OK and a census
tract map with the shaded hazard values will appear as shown in Figure 6.31. In this
case, the user is displaying the default soil map, so all of the census tracts are soil

class D.
Map to Display for Soil Type
[~ Please selectthe type of map to display:
I ¢~ Shaow original input map
& Show hazard values calculated at census tract centroids:
0K ’ Cancel 1
Figure 6.30 Map to Display for Soil Type Dialog.
Inventory Hazard Analysis Results Query ‘Window Mep Help

L Seale [390.320

«1 Srct.shp ‘
(|

+1 Srbndry.shp
(|

Figure 6.31 Soil map with census tract centroid values.
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With the [§@] button (i.e., “Info Tool” button), click on the census tract to be changed.
A dialog window displaying information related to the currently active layer will
appear. In this case they are three layers in the map:
= chrstrst: characteristic soil map
=  SRCT: census tract boundaries
= srbndry: study region boundary (which is not accessible)
By making any of the chrstrst layers active and clicking on the [##] button, Figure 6.32

will appear displaying more information related to the particular location you had
selected in the active layer:

=
.

% ldentify Results

1: Chararcteristic Soil Tw

Shape Foint -
= | Tract 41067031703 —
Stype 4
Lofsuscat i 0
Lndsuscat i 0

5

3

W depth I
Mindist 33618087

hd -

Clear | Clearan | |4 [

Figure 6.32 Identify Results window showing details information of a selected
location.

Note that you can switch between the layers and select different locations in the active
layer with the Info Tool button and have a list of location information displayed at one
time as shown in Figure 6.33. You can switch between any of the locations on the list
and view more information related to the particular location you have selected.

& Identify Results

| 1: Characterstic Soil Tvr o] [ Shane Falygon a
2 Characteristic Soil Ty Tract A NE703501 i
3 Sretohp - 4106703750 Area 2b. 8150

Centlat 4h.074762
Centlong =122 8R5800
Shadevalug i 0
- =
Cloar | clearan | [ 4] | » |

Figure 6.33 The Identify Results window showing a list of locations.
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